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Entering your trial key allows you to save your projects 
and print them during your evaluation period.  Entering 
your license key allows you do the same, except with-
out any time limitations. 

1. Start by opening up an image in Photoshop. 
2. Go to Filters -> Topaz Labs -> Simplify 3 -> Menu -> 
Enter key. 
3. You can then copy and paste or type your key in.

Important: To install the product on a second comput-
er, you will need to download Topaz Simplify and then 
enter your same license key.

Host-Specific Installation
Topaz Simplify is also compatible with Lightroom, 
Aperture and iPhoto.  To use Simplify in any of these 
programs you will need to download and install the 
free Topaz Fusion Express compatibility add on.  You 
can get it online at: www.topazlabs.com/downloads

In Windows, Topaz Simplify is supported by most host 
applications that support Photoshop plug-ins.  This 
includes Paint Shop Pro, Photo Impact, Painter, and 
Irfanview, although there are additional host programs 
that may also support Topaz Simplify. 

To install Simplify in either Paint Shop Pro, Photo 
Impact, or Irfranview first download Topaz Simplify to 
the default location.  Then, to configure it into each 
program following the host-specific instructions on the 
next page. 

Topaz Simplify is a Photoshop plug-in, which means 
it won’t run by itself and requires a compatible host 
program. 

To Install
1. Close Photoshop or other image editing program if 
you are using it. 

2. Open the Topaz Simplify dmg or zip file, double-click 
on the Topaz Simplify installer, and then follow the on-
screen instructions. 

3. Your Topaz plug-ins will automatically be installed in 
your Photoshop plug-ins folder. 

4. After the installation, you will need to enter your 
license or trial key. 

Important for Mac Users: 
After installation, Topaz Simplify will be installed in the 
following folder: “ Macintosh HD -> Library -> Applica-
tion Support -> Topaz Labs -> Simplify 3”.

If your Photoshop is installed in a customized location, 
you will need to manually create a shortcut (alias) link 
inside folder “<Photoshop install folder> -> Plug-ins” 
that links to “ Macintosh HD -> Library -> Application 
Support -> Topaz Labs -> Simplify 3 -> Plug-ins”.

Installation

             Mac Dmg         Windows Zip             Mac Dmg              Mac Dmg 
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1. First launch Paint Shop Pro.

2. Go to File -> Preferences -> File Locations. Select 
“Plug-ins” from the “File Types” list and click “Add”. 

Installation
3. Choose C:\Program Files\Topaz Labs\Topaz Simplify 3 
plug-ins and click “OK”. 

4. Topaz Simplify 3 is now available to use. Simply go to 
Effects -> Plug-ins and select “Topaz Simplify 3”.
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1. First launch  Photo Impact.

2. Go to File -> Preferences -> General or use shortcut 
key F6. 

3. Select Plug-ins from the Categories list. 

Installation
Then click on the           button and browse to find the 
Simplify 3 plug-in folder located in:  C: \ Program Files 
\ Topaz Labs \ Topaz Simplify 3 plug-ins and then click 
“OK”. 

4. Restart Photo Impact.  Go to Menu -> Effect to ac-
cess plug-in.
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1. Make sure that you have downloaded and installed 
the 8bf plug-in add-on, available on the Irfanview 
webpage. (http://www.software.com/irfanview-plugin)

2. Open Irfanview and go to Image -> Effects -> Adobe 
8BF filters. 

3. In the screen that pops up, select “Add 8BF filters” 
and navigate to the C:\Program Files\Topaz Labs\To-
paz Simplify 3 \Plug-ins folder and click “OK”. You will 
then see “Topaz Simplify 3” in the Available/Loadable 
8BF Filters section. 

4. To use Topaz Simplify 3 in the future, simply go to 
Image -> Effects> Adobe 8BF filters again and select 
“Topaz Simplify 3”.

Installation
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Uninstalling
3. Select Programs, then Uninstall a Program.

4. Select Topaz Simplify and click remove. 

Windows 7*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel -> 
Programs -> Programs and Features. 

3. Select Topaz Simplify and click uninstall. 

*Please note that if you also have the 64-bit version of 
Simplify installed, then you will need to first uninstall 
this version before you can uninstall the regular ver-
sion. 

To uninstall Topaz Simplify follow these instructions:

Mac
1. Quit Photoshop (or other editing program).

2. Navigate to the Topaz Labs support files and frames 
located at: Macintosh HD -> Library -> Application Sup-
port -> Topaz Labs. 

3. Locate the Topaz Simplify file and move it to the 
trash.  You will need to enter your system password 
to OK this change. 

4. Navigate to your Photoshop plug-ins folder located 
at: Applications -> Photoshop -> Plug-ins

5. Locate any leftover Topaz Simplify files and move it 
to the trash. 

Windows XP*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel.

3. Double-click on Add / Remove programs.

4. Select Topaz Simplify and click remove. 

Windows Vista*

1. Quit Photoshop (or other editing program).

2. Click on the Start Menu and select Control Panel.

To connect with other Topaz users, participate in Topaz 
contests and to see the latest tips, tricks and tutorials sign 

up for the new Topaz Forum online at:
 www.topazlabs.com/forum
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About Topaz Simplify

Topaz Simplify opens up the traditional art medium 
by bringing digital photographers the tools needed to 
instantly transform any digital image into a work of art.

Simplify can blur the distinction between photographic 
realism and art, allowing you to make your digital im-
age into something that is truly unique to look at. 

Topaz Simplify allows you to easily apply the look of 
brush strokes and other art tools with ease.  Using 
Simplify, you can enhance the essence of your original 
image giving you a dynamic and creative result. 

Topaz Simplify is also great for rescuing previously 
unusable images.  By adding artistic enhancements to a 
damaged, underexposed, overexposed, dull or boring 
image, you can instantly transform it into something 
that is creative, unique and-eye catching. 

The Primary Functions of Topaz Simplify Include: 

1. Remove details from your image based on size. 

2. Enhance or remove color in images.

3. Generate or reduce lines, edges and shading for 
changes in distinctness. 

4. Fine tune images to match your artistic vision.

5. Create a new and artistic interpretation of your digi-
tal images with ease and artistic precision.

6. Rescue unusable images by adding a traditional art 
flare.

Introduction

Original Simplify Cartoon Simplify Sketch

Before Topaz Simplify

After Topaz Simplify
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Topaz Simplify 3.0 Features

1. Auto Updater.  Get software updates instantly.

2. New user interface.

3. Snap / Recall buttons.  Save up to 99 snapshot set-
tings for comparison. 

4. Undo / Redo buttons. 

5. Collapsible side panels.  Expand and collapse the 
preset panel and the tool panel for an adjustable 
workspace. 

6. Collapsible tabs.  Open and close the parameter 
tabs as you need them. 

7. Preset Enable / Disable option.  Option to enable 
or disable the preset preview processing at program 
startup. 

8. Presets Layout.  New preset format with single 
preset preview window. 

9. Preset Navigation.  Use the up / down arrow keys 
to navigate the preset list and display the selected 
preset thumbnail (in preset preview window). Use 
the return (Enter) key to apply the currently selected 
preset.

10. Enable / Disable Tool Tips.  Option to enable or dis-
able the pop up tool tips. 

11. Quick Slider Reset.  Double click on the slider name 
to reset default slider values.

Introduction

Before Topaz Simplify

After Topaz Simplify
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Work Area

Interface (Main View)
Although the Topaz Simplify interface may look intimidating at first glance, don’t worry: it’s actually quite simple and 
easy to use.  You’ll soon be a pro after experimenting with it for a bit.  In order to make sense of the function of each of 
the various controls, we have divided the interface into a few sections:

1

4

1. Presets Preview 5. Settings & Parameters2. Presets Panel 4. Preview Navigator
The removable pre-
view window displays
preset previews. 

Controls the editing using sliders 
to adjust the various effects.

Provides “snapshots”
 of pre-defined effects.

Displays the region of the
preview image you are 
currently focused on. 

3. Preview Window
Displays the preview of the 
original and adjusted image. 

11

44

222
33333
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Work Area

Interface (Tool Panel View)
Use the small white arrows to expand and collapse the preset panel.  You can click the white arrow            or grab the 
edge of the panel and drag it in or out.

ou can click the white arrow            or grab the 
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Work Area

Interface (No Panel View)
Use the small white arrows to expand and collapse the preset and tool panels.  You can click the white arrows                    
or grab the edge of the panels and drag them in or out.

ou can click the white arrows                    ou can click the white arrows                    ou can click the white arrows                    



13

User Manual
To

pa
z 

 S
im

pl
ify

Work Area

Interface (Preset Panel View)
Use the small white arrows to expand and collapse the tool panel.  You can click the white arrow                or grab the 
edge of the panel and drag it in or out.

ou can click the white arrow                or grab the 
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mouse button on the preview image and drag it 
around.  When you let go of the mouse button, the 
new portion of the image will be processed and the 
result will be displayed. 

Preview Section 
The Preview section is the main window that is cen-
tered in the Simplify interface.  The preview section 
shows you the original image and the processed pre-
view of the image.  Click on the image in the preview 
window (or use the Original and Preview buttons) to 
switch between the Original and Preview tabs and 
compare the filtered and un-filtered images. 

Work Area

You can also use SPACE bar or your numbered shortcut 
keys “1” and “2” to switch back and forth between your 
filtered and unfiltered image in the preview window.

111
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The “Ctrl +” and “Ctrl –” keys zoom in and out of the 
image, just like in Photoshop.  

You can use the arrow keys to adjust the value of the 
slider that is currently selected.  

A complete list of the shortcut keys can be found in 
the Shortcut Keys section later in this manual.

You can zoom in or out of the preview image by click-
ing the “+”, or “-” buttons below the preview image.
You can also resize the window as well by dragging 
the bottom right corner in and out. 

The “Fit” button will fit the entire image into the pre-
view window. 

The “100%” button will zoom to 100% view. 

If zoomed below 100% the preview image will be inter-
nally resized in order to speed up preview updating.
 

Work Area

Photoshop and other host software support many Image 
Modes, such as Grayscale, RGB, LAB, CMYK, etc.  Images 
can also be 8, 16, or 32 bits per channel.  Topaz Simplify 
supports both 8 bits per channel and 16 bits per chan-
nel.  Topaz Simplify supports RGB mode only.  To work on 
black-and-white images, first convert them to RGB mode.

Visit the Simplify Gallery to see Topaz Simplify at work:
http://gallery.topazlabs.com/keyword/simplify
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Work Area

Presets
Presets are a great way to speed up and simplify the 
whole process of using Topaz Simplify.  Presets are 
set previews with previously defined settings that you 
can recall and reapply at any time. 

We’ve included some default presets for you and, al-
though they won’t work for every single photograph, 
they serve as excellent starting points for customized 
tweaking.  

Applying Presets 
Applying a default preset is easy and intuitive. Simply 
clicking on a preset will change all the settings in To-
paz Simplify to match those in the selected preset. 

To get the exact results you want, you may still want 
to go through the tabs and tweak the parameters.

Adding Presets
Sometimes it’s convenient to be able to define pre-
sets and save your settings for later use.  To do this, 
first adjust the Topaz Simplify parameters until you’re 
satisfied with the result. Then, click on “Save”. 

 
 

1. Presets Preview
The removable preview 
window displays
preset previews.  Click 
Hide / Show to expand or 
collapse the preset pre-
view window at anytime 
during your workflow.2

2. Presets List
Lists all of the saved pre-
sets available for use. 

1

3. Preset Options

The preset options al-
low you to save your 
presets, delete presets 
(default presents cannot 
be deleted), import new 
presets and export your 
saved presets to share 
with your friends. Remember that you can easily expand or collapse the presets 

panel by clicking on the small white arrow on the edge of the 
panel or by grabbing the panel edge and dragging it in or out.

Additional presets seen here are 
user made presets and are NOT 
included in the release version of 
Simplify 3. However you are wel-
come to also create and save your 
own presets. 

11

22

3
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Work Area
Then enter a preset name, select the type of image 
that it is good for and then enter a description and 
click “OK”.  You can also select a second image cat-
egory type that the preset is good for. 

Note that if the preset name you’ve entered is the 
same as any currently saved preset, then you will be 
asked if  you want to overwrite the current one. 

Your preset will be automatically saved as a new file 
with a “.tpp” extension in the Topaz Simplify Presets 
menu and the preview is automatically generated.  To 
apply it later, just click it like any other preset. 

Deleting Presets
If you’d like to delete a preset the select the preset 
name and then click on Delete.  

Please Note: Default presents cannot be overridden 
or deleted.  Once you delete a preset it or overwrite it 
when saving, then it cannot be retrieved.  

Saved presets are located in the Topaz Simplify “Presets” folder:
C: \ Program Files \ Topaz Labs \ Topaz Simplify \ Presets unless 
you’ve opted to install Topaz Simplify into a different directory. 

Mac users have this folder at Macintosh HD / Library / Applica-
tionSupport /TopazLabs / Simplify / Presets. 
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Work Area
Exporting Presets
To export the preset file to a certain location, click 
“Export”. 

Name your preset and save it to your desktop or 
other specified location that you have reserved for 
saved presets.

You can then share this preset file with others who 
may then import it. 

Sharing Presets
Feel free to share your saved presets by emailing 
them to your friends and having them put it into their 
Topaz Simplify Presets folder.  

Importing Presets
To import a preset file, click the “Import” button.

This will open up a “Browse” box to import a saved 
preset from your computer into Topaz Simplify.  This 
is useful if you have downloaded a preset file that 
you’d like to use. 

Visit the Topaz Labs Blog which features the latest 
Photography, software and design information including 

tutorials, videos, and thoughts about both Topaz and 
non-Topaz topics.

For more information about Simplify be sure to check 
out the Simplify website at: www.topazlabs.com/simplify
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Work Area

Tools
You will use the various tools in the tools panel during 
your workflow to make your image adjustments.

1. Preview Navigator - Displays the region of the
preview image you are currently focused on.

2. Zoom Buttons - Use the zoom buttons to zoom in 
and out of your image.  Or you can also set your image 
to fit the preview window or to view it at 100%. 

3. Undo and Redo buttons

4. Snap and Recall buttons.  Save up to 99 snapshot 
settings for comparison. 

5. Sliders and Parameters - Controls the editing pro-
cess using sliders to adjust the various effects.

6.  Additional Slider Controls - Use the “Reset All” but-
ton to reset all of the sliders values back to zero.  Use 
the “I Feel Lucky!” button to apply randomized 
settings to your image.  This is useful when you 
want to experiment with different settings. 

Have more questions about Topaz Simplify 3 or any of the 
other Topaz software programs?

 Check out the new Topaz Knowledge Base online at: 
www.topazlabs.com/support/kb

1

3

2

6

4

55555
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Checks for available Topaz Simplify updates. 

Click the Show Details button to get find out what’s 
included in the update before you install. 

Menu
You can access Topaz Simplify’s menu by clicking on 
the “Menu…” button at the bottom of the interface. 

Preferences
Select this to enable or disable the program tool tips 
or the Auto-Update feature. 

Work Area
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Contents
Gallery
Select this to open up your Internet browser and go 
to the Topaz Simplify image gallery to see other user 
images enhanced with Topaz Simplify.

MyTopaz
Brings you to the Topaz community where you can 
connect and interact with other Topaz users.  Here 
you can also participate in discussions and contests, 
and share your favorite Topaz images. 

Tutorials
Brings you to the Topaz Simplify tutorials page where 
you can access a variety of helpful video and text tu-
torials.  You can also submit tutorials that you created 
here as well.

About
Select this to see what version of Simplify you cur-
rently have.

Enter Key
Select this to enter your trial or purchased license key. 

What’s This?
Select this (or click F1) then click on a feature in the 
Simplify interface to learn more about it. 

Users Guide
Select it to pull up this user guide.

Tech Support
Brings you to the Topaz Labs support page where 
you can request assistance from our support special-
ists, contact our customer service team, retrieve lost 
license keys, or browse through our Knowledge Base. 

Product Info
Select this to go to the Topaz Simplify web page to 
learn more about the Topaz Simplify plug-in.
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Settings & Parameters 

Parameters
 Topaz Simplify has three settings tabs and a total of 26 
parameters to help you achieve optimal image results. 

Simplify
The Simplify tab controls what details in the image 
are removed and which ones are retained.  Different 
combinations of the settings create many different 
possibilities.  

Simplify Size
Defines the size of the details being simplified.  Any de-
tail with a size below this value will be removed, leav-
ing behind only the larger features.  The value of this 
parameter is relative to the entire image’s size. 

Before Topaz Simplify After Topaz Simplify

Colorspace allows you change the space where the 
simplifying action takes place. The RGB colorspace tends 
to produce more dramatic color effects, while the YCbCr 
colorspace tends to shift color less.
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The Adjust tab offers convenient color controls which 
allows you to alter the brightness, contrast and satura-
tion of the simplified image.  

Brightness
Controls the brightness of the image.  A value greater 
than 1 increases the brightness and a value less than 1 
decreases the brightness.

Contrast
Controls the contrast in the image giving you the ability 
to increase or decrease the appearance of the darks 
and lights in your image proportionally.

Saturation
Increases or decreases the color saturation (richness of 
color) in an image. 

Feature Boost
Boosts the main features in the image and exaggerates 
details. Use this in the RGB color space to introduce col-
orful artifacts into the image.  For more natural image 
colors, switch the colorspace to YCbCr. 

Details Strength
Selectively brings back detail from the “simplified” 
image, and controls the strength of these details.  This 
parameter works with the Details Size slider. 

Details Boost
Controls the weaker details in the image.  A setting 
higher than 1 accentuates weaker details, while a set-
ting below 1 weakens minor image details. 

Details Size
Determines the size of image features to be considered 
“detail” which will be brought back with the Detail 
Strength slider.  The value of this parameter is relative 
to the full image size. 

Remove Small
Removes smaller image details  whose size is below 
this value.

Remove Weak
Removes weaker image details with a strength below 
this value. 

Settings & Parameters 

Need to reset your slider values? 

Simply  double-click on the slider name above the slider 
control to instantly reset the slider value to 0. 
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Adjusts the amount of saturation in the weaker image 
colors without affecting the stronger image colors.  
Setting this value higher than 1.0 will make the color 
more vibrant, while a value of less than 1.0 makes the 
weaker color appear more washed out. 

Edges
The Edges tab brings out, modifies or alternatively cre-
ates edges in the photo.  It also offers the ability to use 
those lines alone or to combine them with the rest of 
the image (known as the base).  While the Simplify and 
Adjust tabs make up the main portion of the image, the 
Edges tab plays an important role in determining the 
size, shape and color of the edges in an image, which 
can affect the final result in many ways.

Settings & Parameters

Inverse Edge Color
Enabling this box will inverse the edge color. By de-
fault, edges are black on a white background.  You 
can use this feature to create white edges on a black 
background.

Edge Strength
Increases the strength of the displayed edges.  This fea-
ture only detects edges that have not been excluded 
by the Simplify Edge parameter.

You can use the Saturation Boost slider’s ability to adjust the 
saturation levels of weaker image colors to create a “selective 
color” effect. 

Simplify offers 8 different 
types of color edges that 
you can use to accentuate 
your image. Choose any 
one of edge types with 
this option. This include 
different combinations 
of color, size and style 
of edge lines. 



25

User Manual
To

pa
z 

 S
im

pl
ify

Settings & Parameters
Simplify Edge
This removes image features of a certain size.  The 
higher this setting is, the less number of edges that will 
remain.  This parameter is analogous to the Simplify 
Size parameter in the Simplify tab. 

Reduce Weak
Reduces edges that are faint or weak in intensity.  This 
feature is ideal when there are stray weak lines around 
the edges that you would like to remove. 

Reduce Small
Reduces edges that are small in size.  This is also ideally 
used with there are small lines around important edge 
detail that you wish to remove.

Fatten Edge
Fattens the image edges, making them thicker.  This 
feature is useful when the original image edges are thin 
or too small. 

The best way to get great-looking images is to experiment with 
the filter until you’re satisfied. Despite the number of sliders and 
settings, getting a great result is easier than you might think!Before Topaz Simplify

After Topaz Simplify After Topaz Simplify

After Topaz Simplify After Topaz Simplify
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Workflow
We will be using this beach image of a couple on their 
wedding day for our example.  The goal for this im-
age is to take it in a more artistic painting direction 
by removing some of the smaller details and lines 
and enhancing the color.  In the following steps, we 
will show you how to achieve optimal results with 
your own photos, following this model. So, let’s get 
started.

1. Open an image file. 

2. Create a duplicate layer of your image.  Right-click 
on your image layer in your layers and select “Dupli-
cate Layer”. You can also achieve this by selecting 
your image layer and dragging it down to the new 
layer icon. 

Sample Project #1
In this section, we will walk you through a sample 
project, step-by-step, to help you become more fa-
miliar with the Simplify program focusing on using a 
combination of presets and manual adjustments.

Before Topaz Simplify

After Topaz SimplifyAfter Topaz SimplifyAfter Topaz Simplify
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Workflow
Again, we want to take this image into a more artistic 
direction by removing details and giving it a painterly 
effect.  Doing this will bring new character to the 
scene.  To achieve this we will be working with the 
presets and sliders for this example, but you can start 
any way you like.

3. To begin working on your image go to Filters -> 
Topaz Labs -> Simplify 3.

4. Once your image loads,  use the zoom tools to 
zoom in on a specific part of your image.  Then you 
can click on the preview and drag it around until you 
find an area that you like. 
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Workflow

If you are satisfied with the preset adjustments then 
you can click “OK” to process your image and save it 
back to Photoshop. 

If you would like to make some additional adjust-
ments to your enhancement settings then you can 
do so by adjusting any of the sliders in the three tabs 
manually until you achieve your preferred image 
results. 

5. If you want to choose a default preset, scroll 
through the panel on the left side of the screen. 
To select it, just click on it and the sliders will 
automatically adjust to the pre-defined settings 
and parameters. For this example we will be 
using the BuzzSim preset.

Don’t forget that you can use the shortcut keys in 
Topaz Simplify 3 to speed up your workflow.
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Workflow
8. The Adjust tab gives you control over the color, 
contrast and brightness of your image.
  

9. Slowly adjust each of the sliders to perfect the 
color in your image.  For this image we will increase 
the Contrast slider just a bit. 

10. We will also gently increase the Saturation and  
Saturation Boost sliders.

When you are happy with the color settings, move to 
the Edges tab. 

6. Start in the Simplify tab.  It is a good idea to begin 
here, and then progress to the Adjust and Edges tabs 
in order to see the effects of your adjustments easily. 

7. Slowly adjust each of the sliders to create the op-
timal exposure in your image.  For this image we will 
only increase the Simplify Size slider slightly allowing 
more of the smaller details to be removed. 

When you are happy with the Simplify settings, move 
to the Adjust tab. 

Remember: You can use the Saturation Boost slider’s ability to 
adjust the saturation levels of weaker image colors to create a 
“selective color” effect. 
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Workflow
are happy with the new artistic look of your image then 
you are ready to process your changes. 

11. Click OK and watch your image transform into a 
beautiful artistic masterpiece. 
 

The Edges tab is where you can really make the objects 
in your image pop by enhancing or minimizing the edge 
detail. 

11. Use the Original and Preview tabs to switch be-
tween your original image and your Simplified image 
to see the difference.  You can also use your spacebar 
shortcut key to do this as well. 

If you want to make some additional adjustments you 
may do by continuing your work with the sliders. If you 

Before Topaz Simplify

After Topaz SimplifyAfter Topaz SimplifyAfter Topaz Simplify
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Before Topaz Simplify
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Workflow

After Topaz Simplify
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2. Create a duplicate layer of your image.  Right-click 
on your image layer in your layers and select “Dupli-
cate Layer”.  You can also achieve this by selecting 
your image layer and dragging it down to the new 
layer icon. 

3. To begin working on your image go to Filters -> 
Topaz Labs -> Simplify 3. 

Sample Project #2
In this project, we will walk you through a second Sim-
plify workflow  to show you how easy it is to instantly 
turn your digital image into a work of art. 

                                                                                    

We will be using this photo of a playground for our 
example.  In the following steps, we will show you 
how to achieve optimal results with your own photos, 
following this model.  Let’s get started.

Workflow

Please visit the Topaz Simplify website at http://www.to-
pazlabs.com/simplify for video tutorials, tips, and tricks!

                                                                                                                                                                        

Before Topaz Simplify

After Topaz Simplify
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select it, just click on it and the sliders will automati-
cally adjust to the pre-defined settings and param-
eters. 

For this example we will be using the Painting Harsh 
Color preset.

Once your image loads,  use the zoom tools to zoom 
in on a specific part of your image.  Then you can click 
on the preview and drag it around until you find an 
area that you like. 

We want to take this image into a more creative and 
artistic direction, so we will begin working with the 
default presets and then move to the sliders, but you 
can start any way you like.

 5. If you want to choose a default preset, scroll 

Work Flow

 5. If you want to choose a default preset, scroll  5. If you want to choose a default preset, scroll 
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a single selection will give you optimal image results. 

If you are satisfied with the preset adjustments then 
you can click “OK” to process your image and save it 
back to Photoshop.

If you would like to make some additional adjust-
ments to your enhancement settings then you can 
do so by adjusting any of the sliders in the three tabs 
manually until you achieve your preferred image 
results. 

Don’t forget that you can use the shortcut keys in 
Topaz Simplify 3 to speed up your workflow.

Work Flow

Additional presets seen here are 
user made presets and are NOT 
included in the release version of 
Simplify 3. However you are wel-
come to also create and save your 
own presets. 



36

User Manual
To

pa
z 

 S
im

pl
ify When you are happy with the Simplify  settings, move 

to the Adjust tab. 

8. The Adjust tab gives you control over the color, 
contrast and brightness of your image.  

9. Slowly adjust each of the sliders to perfect the 
color in your image.  For this image we will slightly 
increase the Saturation and Saturation Boost sliders.

When you are happy with the color settings, move to 
the Edges tab. 

6. Start in the Simplify tab. It is a good idea to begin 
here, and then progress to the Adjust and Edges tabs 
in order to see the effects of your adjustments easily. 

7. Slowly adjust each of the sliders to create the 
optimal exposure in your image.  For this image we 
will slightly decrease the Simplify Size slider to bring 
back in some of the smaller details and also slightly 
increase the Feature Boost slider.

Work Flow

Visit the Topaz Simplify image gallery to checkout over 
200 user-submitted Simplify images. 

Visit: http://gallery.topazlabs.com/keyword/simplify
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Workflow
The Edges tab is where you can really the objects in your 
image pop by enhancing or minimizing the edges in your 
image. 

11. Use the Original and Preview tabs to switch be-
tween your original image and your Simplified image 
to see the difference.  You can also use your spacebar 
shortcut key to do this as well. 

If you want to make some additional adjustments you 
may do by continuing your work with the sliders. 

If you are happy with the new artistic look of your
image then you are ready to process your changes. 

11. Click OK and watch your image transform into a 
beautiful artistic masterpiece. 

Before Topaz Simplify

After Topaz Simplify
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Glossary
Color Profile - defines the range of colors that can ap-
pear in a digital photo.

Desaturate - Decreasing the intensity of a color (hue).

Download - The process of transmitting or transfer-
ring data from one device to another.

Export - Outbound data transfer in a format that can 
be used by other programs.

Import - Inbound data transfer into a file or docu-
ment.

Pan and Zoom - A useful function that allows users to 
magnify the captured image in the preview and then, 
by using the cursor, to move or pan around the image. 
Typically Pan and Zoom allows users to magnify the 
image 2x or 4x time.  By magnifying the images and 
zeroing in on a specific section, you can see details 
not visible when the entire image is sized to fit the 
preview.

Parameter - A numerical or other measurable factor 
forming one of a set that defines a system or sets the 
conditions of its operation.

Photo-editing or Imaging software – Programs in 
which you can alter your photos and / or create digital 
images.  Depending on the software, you can improve 
exposure, color and other attributes of your picture, 
paint on it, add type, apply special effects, remove 
noise, resize it, combine it with other pictures, pre-
pare it for e-mail or posting on the web, output it to a 
printer, or do any number of other manipulations or 
edits.

Achromatic - Without color.

Adjustment Layer – A layer that allows you to adjust the 
look of an original image with out making it permanent. 
With adjustment layers you can make various changes to 
a layer without damaging it and go back and readjust it at 
anytime.

Algorithm - Any bit of code or programming that de- 
fines a process.

Brightness - The degree to which a color sample ap-
pears to reflect light. 

Chroma - Purity or intensity of color.  The difference 
of a color against the brightness of another color that 
appears white under similar viewing conditions.

CMYK - Cyan, magenta, yellow, and black. A color 
model commonly used for 4-color printing by printers 
to define and mix all of the colors they are capable of 
outputting.

Color - The human perceptual response to different 
wavelengths of light impinging on the photo recep-
tors in the retina.

Color channel - The visual component of a color digi-
tal image that represents all the pixels in that picture 
made up of a specific primary color.  In a typical digital 
photo, the primary colors of red, green and blue 
(from the RGB color model) create all the colors in 
that photo, which may be represented by three color 
channels, each of red, green or blue.
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Glossary
Plug-in - A computing feature with the ability to be 
added to a system to give extra features or functions.

Preset - A pre-defined combination of parameters and 
settings that is saved into a folder within Topaz Detail 
2.  Topaz provides default presets.  A preview of each 
preset can be seen in the preset preview window lo-
cated at the top left hand side of the interface above 
the preset list. 

Preview- Shows the processed preview of the image.

RAW image - An image file format that contains un- 
touched, “raw” pixel information straight from the 
digital camera’s sensor.  It has yet to translate the in-
formation in each pixel into the full color information, 
so this format offers more control over how the final 
JPEG or TIFF image is generated. 

Refine – Improve (something) by making small changes to 
make it more subtle and accurate. 

RGB - Red, Green, Blue.  The color model that is used 
in digital cameras and by computer monitors.

Saturation - The difference of intensity within a spe-
cific hue.

Shadow - A dark area or shape produced by a body 
coming between the rays of light and a surface.

Sharpness - The clarity of detail in a photo.

Smoothing - To make a surface more regular or con- 
sistent; free from perceptible projections, lumps, or 
indentations.

Before Topaz Simplify

After Topaz Simplify
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ify Topaz_Simplify3.plugin file into the Photoshop Plug-Ins 

folder. 
3. Quit and restart Photoshop and Topaz Simplify 3 will 
appear in your Filters menu. 

“Do you have any other Simplify tutorials?”
Yes, please see pages 26 and 33of this Topaz Simplify 
user guide, and also visit: http://www.topazlabs.com/
tutorials/simplify

“I do not have Photoshop, will  Simplify work with 
my Elements, Aperture, Lightroom, iPhoto Paint Shop 
Pro, Photo Impact or Irfanview?”
Yes, you can use Topaz Simplify with any of the above 
host programs. However, to use Simplify in Aperture, 
Lightroom or iPhoto, you will need to download the 
free Topaz Fusion Express plug-in.  For more informa-
tion please visit: www.topazlabs.com/fusion

“What are the limitations of the trial version of your 
software?”
The only limit on the trial versions of the Topaz plug-ins 
is time.  The free trial versions are designed to enable 
you to experience the full functionality of our plug-ins 
for a 30-day trial period.  After the trial period is up, you 
will only be able to use the Topaz software by purchas-
ing it.  You will then receive a license key to activate the 
plug-in, and the trial version will automatically become 
the full version with no time limitations.          

“I need a Topaz Simplify trial key.” 
Visit http://www.topazlabs.com/downloads for a trial 
key.  Please check your Spam folder because your 
Spam filter sometimes filters out the automated email. 

If you need more time to evaluate, please e-mail us at 
www.topazlabs.com/support for an extended trial key. 
 

 “I can’t find Topaz Simplify in the Photoshop Filters 
menu.” 
If you’re using Windows: 
1. Go to C: \ Program Files \ Topaz Labs \ Topaz Simplify 
3 \ Plug-ins. Right click the file “tlsimplify3.8bf” and 
click “Copy”. 
2. Go to your Photoshop Plug-Ins folder, usually located 
at C: \ Program Files \ Adobe \ Photoshop CSx \ Plug-Ins. 
First, delete anything that is currently there that has to 
do with Topaz Simplify 3 This includes any folder that 
might be labeled “Topaz Simplify 3” or any 
tlsimplify3.8bf file. After doing that, right-click on any 
empty space and click “Paste”. 
3. Quit and restart Photoshop and Topaz Simplify will 
appear in your Filters menu. 

If you’re using Mac: 
1. Go to Macintosh HD / Library / Application Support /
Topaz Labs / Simplify3 / Plug-ins and right-click Topaz_
Simplify3.plugin. Click “Copy”. 
2. Go to Applications / Adobe Photoshop CSx / Plug-Ins 
(or wherever your Photoshop Plug-Ins folder is lo-
cated). Delete any current reference to Topaz Simplify 
3. Afterwards, right-click any empty spot and paste the 

Frequently Asked Questions
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Frequently Asked Questions
“If I use the 30-day trial version will I need to uninstall 
the trial version before I upgrade to a full version?”
No, the Topaz trial software is designed to be unlocked 
to become the full version simply by entering a license 
key.  The full license key will be e-mailed to you immedi-
ately after you purchase the software.

“Where do I enter my key?”
To enter your key please open an image in Photoshop 
and go to Filter -> Topaz Labs -> Simplify 3 -> Menu -> 
Enter Key.  You can then copy & paste or type in your 
license key and then select OK.

“I had Topaz Simplify as a trial, then I purchased. How 
do I enter my new license key?”
You can enter your new license key by opening up an 
image in Photoshop and go to Filter -> Topaz Labs -> 
Simplify 3 -> Menu -> Enter Key.  Please remove the trial 
key and enter your new purchased license key, then 
select OK and you are all set. 

“My Topaz Simplify key doesn’t work!”
There are a couple of reasons why Topaz Simplify might 
think your key is invalid.

First, make sure that your key is in the proper format. 
It’ll be in the format “xxxxxx-xxxxxx-xxxxxx-xxxxxx-
xxxxxx” and will be all numbers in 30 digits in five 
groups of six (no letters). 

Second, make sure that as you’re entering the key 

there is nothing in the space beforehand.  This means 
clicking, pressing Ctrl-A, and hitting delete to make sure 
that absolutely nothing is in that field before you paste 
in the key.

If it doesn’t work when you copy and paste, try typing 
it out, and vice versa.

My Topaz filters are grayed out in the filter menu. 
Please make sure that you are using a 8-bit or 16-bit 
image that is in RGB color mode.  Also, if your project 
includes adjustment layers please make sure that you 
are not on an adjustment layer.  You will need to select 
the image layer.  This will allow you to access your To-
paz programs. 

I have a question not listed here. 
Please visit our knowledge base online at: 
http://www.topazlabs.com/support/kb/

If you are not able to find the answer there then con-
tact our support specialists online at: www.topazlabs.
com/support or e-mail customer support at: help@
topazlabs.com

http://www.topazlabs.com/support/kb/
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Shortcut Keys
Topaz Simplify uses some shortcut keys to speed up your workflow. Many of these 
keys are similar to those in Photoshop. The following keys work at all times.  

Mac  and PC Shortcuts are the same unless indicated otherwise. 

S					          	 Expands / Collapses Simplify Tab
A						      Expands / Collapses Adjust Tab
E						      Expands / Collapses Edges Tab
S					          	 Takes a Snapshot
CMD-Shift-P		   CTRL-Shift-P   	 Recalls previous Snapshot
CMD-Shift-N		   CTRL-Shift-N		 Recalls next Snapshot
CMD-1			   CTRL-1		  View Original Image
CMD-2			   CTRL-2		  View Adjusted Image
Left or Right Arrow Key		      	 Scrolls through presets
Return (enter) key			        	 Applies selected preset
[ key 					          	 Reduces selected slider value by 0.1
] key					          	 Increases selected slider value by 0.1
Home Key 				         	 Set the slider value to minimum
End Key			       	      	 Set the slider value to maximum
Double-click slider name		       	 Resets the slider to it’s default value

Spacebar		       Spacebar	      	 View Original Image	
CMD-ALT-R		    CTRL-ALT-R      	 Reset All	
Zoom to Fit		  CMD-0		   CTRL-0
Zoom to 100%	 CMD-ALT-0		  CTRL-ALT-0
+ or CMD - +		    + or CTRL - +     	 Zoom In	
- or CMD - - 		  - or CTRL - -          	 Zoom Out			              
CMD -Z 		    Ctrl - Z	      	 Undo				               
CMD - Shift - Z	   Ctrl - Shift - Z    	 Redo				              		

MAC Shortcut 	      PC Shortcut 	      Action
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Connect with Topaz

Follow us on Twitter for notifications of 
recent news and easily get in touch with us 

whenever you feel like it!

Find us on our Facebook page and network 
with other Topaz users!

Participate in the entirely user-led Topaz 
Flickr group for a helpful and highly active 
community for Topaz Photoshop plug-ins!

Subscribe to our YouTube channel to keep 
up with any newly released product video 

tutorials!

Check out our new Forum and our blog for 
tutorials, tips and updates from Topaz Labs!

http://www.topazlabs.com/forum
http://www.facebook.com/pages/Topaz-Labs/19955996369
http://www.flickr.com/groups/topaz
http://twitter.com/topazlabs
http://www.youtube.com/topazlabs
http://www.topazlabs.com/forum
http://www.topazlabs.com/blog
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Topaz Labs LLC, a privately owned company in Dallas, Texas, focuses on developing advanced video and image enhance-
ment technology. With today’s widespread use of digital still cameras, digital video cameras, and HDTV, the need for high-
quality digital images and videos has greatly increased. Topaz Labs’ mission is to bring practical state-of-the-art image and 
video enhancement technology to both professionals and consumers.

Contact Information
	

Topaz Labs LLC
5001 Spring Valley Road
Suite 400 East
Dallas, TX 75244

Technical Support
Visit: http://topazlabs.com/support/

Copyright © 2009 Topaz Labs, LLC. All rights reserved. http://www.topazlabs.com
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Image Plug-ins    

Go to http://www.topazlabs.com/downloads to get your 30-day free trial!

Ultimate control over 
image exposure, detail, 
and color gives you the 
power to make your 
photos pop.

Specializes in creat-
ing crisp and stylized 
images. Also features 
extensive smoothing 
capabilities. 

Advanced noise reduc-
tion filters noise while 
maximizing and retain-
ing image detail simply 
and effortlessly.

Takes any of your 
regular photos and ef-
fortlessly turn them into 
beautiful works of art.

Specializes in overall 
image improvement. 
Features sharpening, re-
constructing, enlarging, 
high-quality noise 
removal and JPEG arti-
fact damage tools. 

Increase video quality with this suite 
of video enhancement filters utilizing 
super-resolution technology. 

Advanced JPEG artifact 
reduction filters elimi-
nate JPEG compression 
artifacts while preserv-
ing image detail like 
never before. 

Video Plug-ins 

3 levels of intricate and 
specific detail enhance-
ment for naturally 
enhanced images with 
no halos. 

Bring the power of 
Topaz to your Aperture, 
iPhoto and Lightoom 
workflow with the new 
Fusion Express plug-in.

Remove unwanted 
backgrounds from your 
digital images quickly 
and easily with the new 
Topaz ReMask. 

Easily and efficiently capture video 
frames and significantly increase their 
quality and resolution with this stand-
alone Windows application. 




